## Table of Contents

- Product Guide .............................................................................................................. 1
- Table of Contents ........................................................................................................ 2
- What's new in Performance Manager 10.1? ................................................................. 4
  - Removal of Memory Optimizer ................................................................................. 4
  - Removal of Optimizer Monitor .................................................................................. 4
  - Removal of Disk Scheduling ...................................................................................... 4
  - Removal of Performance Manager Agent Driver ...................................................... 4
  - Support for Windows Server 2016 ............................................................................ 4
- Performance Manager Features ..................................................................................... 5
  - Application and Process Discovery ........................................................................... 5
  - Application Groups ................................................................................................... 5
  - User Groups ................................................................................................................ 5
  - Conditions .................................................................................................................. 6
  - CPU Resource Management ...................................................................................... 6
  - Memory Management ................................................................................................. 7
  - Licensing .................................................................................................................... 7
  - Auditing ...................................................................................................................... 7
  - Configuration Profiler ............................................................................................... 8
  - Working in Passive Mode ............................................................................................ 8
- Licensing ........................................................................................................................ 9
  - About the Licensing Console ..................................................................................... 9
  - Managing Licenses ..................................................................................................... 9
  - Export License Files ................................................................................................... 11
  - Import License Files ................................................................................................. 11
  - Troubleshooting ......................................................................................................... 11
- Service Packs ................................................................................................................ 12
  - Installing Service Packs ............................................................................................ 12
  - Rolling Back Service Packs ....................................................................................... 13
- Managing Configurations .............................................................................................. 14
  - About Configuration Files .......................................................................................... 14
  - Open, Save and Export Configurations ...................................................................... 14
  - Preset Configurations ............................................................................................... 16
  - Using System Center Configuration Manager for Configurations .......................... 17
  - Configuration Profiler ............................................................................................... 18
  - Resolve Configuration Violations ............................................................................. 20
- Feature Options ............................................................................................................. 21
| Feature Usage | 21 |
| Application Memory | 22 |
| Excluded Applications | 23 |
| Multi-process Applications | 24 |
| General | 25 |
| Application Groups | 27 |
| Create Application Groups Manually | 27 |
| Create Application Groups Using Application Discovery | 29 |
| Resource Planning | 31 |
| Evaluation Order | 31 |
| Resource Planning Nodes | 31 |
| Resource Planning Sub-nodes | 33 |
| Windows Fair Share | 38 |
| Thread Throttling | 40 |
| Configure Thread Throttling | 41 |
| Include System Processes in Thread Throttling | 43 |
| Auditing | 44 |
| About Auditing | 44 |
| Local Events | 45 |
| Environment Variables | 48 |
| Streamed Applications | 49 |
What's new in Performance Manager 10.1?

Removal of Memory Optimizer

The following console functionality has been removed:

- User Memory tab.
- Optimizer and User Memory references from the Features Usage tab.
- The Resource Configuration tree view > Global Resources > Memory Optimizer node.
- The Memory Optimizer view.

Removal of Optimizer Monitor

The following console functionality has been removed:

- Optimizer Monitor navigation bar.
- Monitoring references within the Performance Manager ribbon.

Removal of Disk Scheduling

The following console functionality has been removed:

- Disk Scheduling

Removal of Performance Manager Agent Driver

The removal of the driver from the agent means that no reboot is required on installation.

Support for Windows Server 2016

Performance Manager is compatible with Microsoft Windows Server 2016.
Performance Manager Features

Application and Process Discovery

Application Discovery allows you to automatically populate Application Groups with Desktop Applications, Services or 16-bit Applications. You can select items to include in an Application Group from the results of a discovery, which are displayed in categories based on application type:

- **Desktop Applications** discovers Installed Applications, Running Processes and File Types.
- **Services** discovers Installed Applications and Services.
- **16-bit Applications** discovers 16-bit Applications by searching running NTVDM services for the specified 16-bit applications to run as if they were executed on a DOS machine) services for the specified 16-bit applications.

**NOTE:** NT Virtual DOS Machine. Allows 16-bit applications to run as if they were being executed on a DOS machine.

**NOTE:** 64-bit Windows operating systems do not support 16-bit applications.

Application Groups

Application Groups are groups of Desktop Applications, Services or 16-bit Applications. You can define Application Groups to create custom lists of applications which you assign to rules for managing the demand on CPU, memory or resources. The groups indicate specific files or folder names, and path and command line attributes with pattern matching, using wildcards and regular expressions.

Desktop Applications, services or 16-bit applications can be collated to create Application Groups which can be automatically populated using the Application Discovery function.

User Groups

User Groups are a generic way to refer to a single Windows user account or Windows Group within the Performance Manager console. As an Administrator you can use one or more User Groups to customize the way Performance Manager is deployed across your network.
Conditions

Use Conditions to define criteria for when resources are allocated to applications or users. Conditions depend on a match with the state of the window, session or desktop, or combinations of each.

CPU Resource Management

CPU Management controls the distribution of CPU resources to applications and users on the system, and includes the following:

- **Share Factors** – Allocate relative proportions of the CPU resources to applications and users. Share factors ensure optimum performance at peak load and continuously regulate the fair distribution of available processor resources.

- **Reservations** – Ensure that certain applications and users are guaranteed specific levels of CPU resources, as the need arises. At times of peak demand on the system, the minimum reserved resources are obtained and the remaining resources are reallocated according to share factors allocated to other applications.

- **Limits** – Prevent certain applications and users exceeding specific levels of CPU capacity when others demand their share. CPU intensive use can be managed by Hard Limits or Soft Limits. Hard limits are fixed proportions of the processor load beyond which applications and users cannot exceed even when spare capacity is available. Soft limits are more flexible and only confine applications and users within certain levels during peak load to free up resources. When general demand falls back again and resources are released, controlled applications and users can exceed limits and resume more CPU intensive activity.

- **CPU Affinity** – Assigns Application Groups and User Groups to specific CPUs when operating on multiprocessor servers.

- **Thread Throttling** – Patented technology which dynamically clamps processor intensive tasks when CPU load is too heavy whilst including flexible settings for modifying thresholds and ranges.
Memory Management

Memory Management controls the distribution of memory resources on the system and includes the following:

- **Hard Limits** - Are always imposed and used to define proportions of the processor load beyond which applications cannot exceed even when spare capacity is available.

- **Soft Limits** - Are less rigid than Hard Limits and only confine applications within certain levels during peak load to free up resources.

- **Application (Virtual) Memory Limits** – Sets limits on memory use on a per application basis and allows you to close or terminate applications when allocated memory limits are exceeded. The Close option generates a prompt to the user to close an application after the specified period. The Terminate option forces the application to stop after the specified period.

  **NOTE:** The Terminate option will result in the loss of data for the application being terminated.

- **Physical Memory Limits** – Sets limits on the use of physical memory by applications. Minimum limits guarantee adequate resources are available ensuring applications function correctly. Maximum limits prevent resource intensive applications from causing congestion on the system.

  You can also select application memory trimming to reduce unnecessary consumption at process startup and when the state of the application window, user session or desktop changes.

Licensing

Use the AppSense DesktopNow Licensing console to manage the licenses for your Performance Manager installation.

Auditing

The Auditing node is used to configure event logging. Settings allow you to specify where to log events and which events to include in the audit. Auditing can also be managed in the AppSense Management Center.

See the AppSense Management Center Help for more information.
Configuration Profiler

The Home tab includes the Configuration Profiler option for displaying a summary report of the Performance Manager configuration rules. The reports can be used to analyze configurations before implementing them on a live system.

The Configuration Profiler report includes the details of Feature Options, Application Groups, Resource Planning, and Thread Throttling.

Working in Passive Mode

Each of the Performance Manager configuration settings can be optionally set to monitor performance control actions affecting processor and memory utilization before you commit to the policies for taking corrective action.

In Passive mode, auditing data continues being recorded, when enabled in the configuration, except for CPU Share Factors, Reservations and Soft limits.

You can apply Passive Mode to each feature using the Feature Options dialog which you access by selecting Options on the Resources Setup ribbon. You can also include or exclude system processes for certain features in this dialog.
Licensing

About the Licensing Console

AppSense DesktopNow Licensing console allows you to manage AppSense DesktopNow product licenses. The Licensing console allows you to:

- Manage licenses for single products, the AppSense DesktopNow Suite and Evaluation licenses.
- Export license packages to MSI or LIC file format for saving to the AppSense Management Center or other computers which can be remotely accessed.
- Import and manage licenses from LIC file format.

For information about license deployment to endpoints, see AppSense Management Center Help.

Managing Licenses

License details are included in the License Agreement which is issued when an order for AppSense software has been completed.

The License Agreement includes the following information:

- Product, Feature, and Version Details
- Issue Date
- Expiry Date
- Customer Name
- Serial ID

Together with the license agreement you will receive either a TXT file or a LIC file. Use these in the AppSense Licensing Console to add or import the license.
Add a License

1. Open the AppSense Licensing console.
2. Click Add.
   The Add License Key dialog displays.
3. Enter the License Key and click Add.
   If you received a TXT file from AppSense, open the file and copy the license key, paste it in to the Add License Key dialog.
   If you received a LIC file from AppSense, refer to "Import License Files" on the facing page.

Details of the license are displayed in the console and the license key is added to the following location:
%ALLUSERSPROFILE%\AppSense\Licenses

Activate a License

Once added, some licenses require activating.

1. Select a license or add one to the licensing console.
2. Click Activate.
3. Type or copy and paste the activation code.
4. Press Enter to accept the code.

The license console saves the license key to the MS Windows registry on the local machine. The License Status field updates to show the status of the license and the license details display in the lower part of the console.

**NOTE:** To check that the license is active on your endpoint, search the registry for the license code. If the search finds the code, then the license is active.

Remove a License

1. Highlight the required license and click Remove.
   A confirmation dialog displays.
2. Click Yes to confirm.

The selected license is deleted and removed from the console and the MS Windows registry or %ALLUSERSPROFILE%\AppSense\Licenses location, whichever is applicable to the license type.
Export License Files

Export licenses to an MSI or LIC file to create a backup and enable distribution to other endpoints using the Licensing console or the Management Center.

1. Highlight the license you want to export.
2. Click **Export** to display Windows Save As dialog.
3. Browse to the required location to save the license file.
4. Enter a name for the file.
5. Select the file type: MSI or LIC.
6. Click **Save**.

A file is created and saved in the selected location. This file can be copied to any network location and loaded via the AppSense DesktopNow Suite Licensing console or in the Management Center console.

Import License Files

Import a previously exported license to an endpoint using the Licensing console.

1. Open the AppSense Licensing console.
2. Click **Import** to display the Windows Open dialog.
3. Navigate to the required LIC file.
4. Click **Open**.

Details of the license are displayed in the console and the license key is added to the following location:

%ALLUSERSPROFILE%\AppSense\Licenses

Troubleshooting

I received an AppSense license, what do I do?

If you have received an AppSense product license you can load the license by launching the AppSense DesktopNow Suite Licensing Console on your client computer and entering the license code.

I have entered an AppSense license, but it says it is not activated, why?

Some AppSense licenses require activation before they can be used. Activation codes are provided by AppSense. Activate a license by entering the License and Activation codes into the console.
Service Packs

AppSense Service Packs are self contained packages or patches that are used to update specific files within a DesktopNow application without reinstalling the full application. Service packs can be applied more often and reduce the need for system restarts on your endpoints. Service packs are delivered as a Windows Installer patch (MSP) file and are often referred to as patch files.

Installing Service Packs

Service Packs can be installed or deployed using the same technology and techniques used when installing MSIs. Both Microsoft System Center and the AppSense Management Center 8 FR4 or later can deploy MSPs. If neither of these products are available, service packs can be installed using the command line interface.

For example, the command:

```
msiexec.exe /p PerformanceManagerAgent64.msp
```

installs any files that have been amended as part of the patch for just Performance Manager 64 bit agent.

The following command installs the base version of the Performance Manager Agent (MSI) and the Performance Manager patch file (MSP) simultaneously:

```
msiexec.exe /i PerformanceManagerAgent64.msi
PATCH=c:\fullpath\PerformanceManagerAgent64.msp
```

**NOTE:** A base version must be installed before the patch file can be applied.

If the patch file contains driver or hook files that are currently in use on the machine the patch is being applied to, you are informed that a reboot is required. If you chose to continue, the system is restarted when the patch has been applied.

For information on installing and upgrading service packs using Management Center, see the AppSense Management Center Help.

Installation Order and Dependencies

It is recommended that all components of a service pack are installed.
Rolling Back Service Packs

There are two ways to roll back, or uninstall AppSense Service Packs:

- Using the Windows Control Panel Programs and Features.
- Using Management Center 8 FR4 or later

Rolling Back Service Packs Using Management Center 8 FR4 or Later

1. In the Management Center console, select Overview > Deployment Groups tab > Deployment Groups.
2. Highlight the Deployment Group and select Settings > Assigned Packages.
   The Assigned Packages work area displays a list of all the AppSense products and their associated packages.
3. Highlight the required Application Manager service pack and click Unassign from the Actions menu.
4. Click Review and Submit.
   The Submit Changes dialog displays.
5. Check the details are correct and click Submit.

The patch is unassigned based on the deployment group Installation Schedule.
Managing Configurations

About Configuration Files

Performance Manager configuration files (APMP files) contain the policies for managing performance and resources on an endpoint. The Performance Manager Agent checks the rules contained within the configuration to determine the actions to take for managing performance.

Configurations are stored locally in %PROGRAMDATA%\AppSense\Performance Manager.

If using just the Performance Manager product, configuration changes are written directly to the local APMP file from the Performance Manager console. If you are using Performance Manager as part of the DesktopNow suite of products with AppSense Management Center, configurations are created and stored centrally in the AppSense Management Center database and distributed to endpoints in MSI format.

Configurations can also be exported and imported to and from MSI format, which is useful for creating templates or distributing configurations using third party deployment systems.

Open, Save and Export Configurations

The File menu, in the top left-hand corner of the console, allows configurations to be opened, saved, imported and exported. Application Manager saves configurations in APMP (AppSense Performance Manager Package) file format.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new default configuration which is locked for editing.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens an existing APMP configuration file for editing from one of the following locations:</td>
</tr>
<tr>
<td></td>
<td>• Live configuration on this computer.</td>
</tr>
<tr>
<td></td>
<td>• Configuration from the Management Center.</td>
</tr>
<tr>
<td></td>
<td>• Configuration from System Center Configuration Manager.</td>
</tr>
<tr>
<td></td>
<td>• Configuration file from disk.</td>
</tr>
<tr>
<td>Save</td>
<td>The Save options are specific to the use of the configuration with the AppSense Management Center:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Save and continue editing</strong> - Saves the configuration and keeps it locked whilst open for editing. Configurations cannot be deployed whilst locked.</td>
</tr>
</tbody>
</table>

Copyright © 2016, AppSense. All Rights Reserved.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save and unlock</strong></td>
<td>Saves the configuration and unlocks it to allow deployment. The current configuration closes and a new default configuration opens.</td>
</tr>
<tr>
<td><strong>Unlock without saving</strong></td>
<td>Unlocks the configuration without saving any changes made. The current configuration closes and a new default configuration opens.</td>
</tr>
</tbody>
</table>

**Save As**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Live configuration on this computer</strong></td>
<td>Save the current configuration on the current computer and apply it as the working configuration.</td>
</tr>
<tr>
<td><strong>Configuration in the Management Center</strong></td>
<td>Creates the current configuration in the package store on the selected Management Center.</td>
</tr>
<tr>
<td><strong>Configuration in System Center Configuration Manager</strong></td>
<td>Saves your configuration to the specified System Center Configuration Manager server.</td>
</tr>
<tr>
<td><strong>Configuration file on disk</strong></td>
<td>Saves the current configuration as a file on a local or network drive in APMP format.</td>
</tr>
</tbody>
</table>

**Import and Export**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Import configurations from MSI</strong></td>
<td>Imports a configuration from an existing MSI package, for example, legacy configurations which have been exported and saved from legacy Consoles.</td>
</tr>
<tr>
<td><strong>Export configuration as MSI</strong></td>
<td>Exports the current configuration as an MSI package.</td>
</tr>
</tbody>
</table>
Preset Configurations

When the Performance Manager Console is opened or a new configuration is created, preset configurations are available to cater for most types of environments. If the presets do not meet the requirements of your environment, configurations can be created manually.

The following preset configurations are available:

- **General Purpose** - This configuration is optimized for general purpose use. Thread Throttling is configured for all non-system processes and CPU priority is given to system processes.

- **Physical Desktop** - This configuration is optimized for physical desktops. Thread Throttling is configured for all processes and CPU priority is given to system processes. CPU Reservations and Application Memory Limits features are enabled.

- **Terminal Services / Remote Desktop Services (RDS)** - This configuration is optimized for Terminal Services/Citrix XenDesktop environments. Thread Throttling is configured for all processes. CPU Reservations, Application Memory Limits and Physical Memory Control are all enabled.

- **Virtual Desktop Infrastructure (VDI)** - This configuration is optimized for VDI environments. Thread Throttling is configured for all processes. CPU Reservations, Application Memory Limits and Physical Memory Control are all enabled.
Using System Center Configuration Manager for Configurations

System Center Configuration Manager (SCCM) is a systems management software product by Microsoft for managing large groups of Windows-based computer systems. Configuration Manager provides the following:

- Remote control
- Patch management
- Software distribution
- Operating system deployment
- Network access protection
- Hardware and software inventory

**NOTE:** For more information on System Center Configuration Manager, see Configuration Manager. AppSense Performance Manager allows configurations to be opened and saved using System Center Configuration Manager version 2012 onwards.

Connect to System Center Configuration Manager Server

When opening or saving a configuration to SCCM, a dialog displays and allows you to connect to a System Center Configuration Manager Server and maintain a list of servers.

The following settings are available:

- **New Server** – Click to add a new server to the list by providing details in the Add System Center Configuration Manager Server dialog, including friendly name, server name (computer name or IP address). Use the Location field to specify the network location to be used to store your configuration files. The configuration location should be readable for the users who are to view the configuration or writable for those users who will be saving configurations.

- **Edit Server** – Click to edit a listed server by providing details in the Edit Server dialog, including, friendly name, server name and edit the location that your configuration are to be stored on your network.

- **Delete Server** – Remove the highlighted server from the list.

Highlight the server you want to connect to, click Connect and provide credentials for connecting to the selected server, either using the currently connected user account or a custom user. You can browse for a user on the active directory or local network, provide a password and, where appropriate, the domain.

**NOTE:** To use SCCM remotely, some additional configuration is required. For further information, see Configure DCOM Permissions for Remote Configuration Manager Console Connections.
Configuration Profiler

The Configuration Profiler, available from the Home ribbon, allows administrators to produce detailed reports on configurations. This can be done whether they are stored locally or centrally. The reports can be a general study of the overall configuration or can be aimed at how it interacts with a specific user, group of users or specific file.

This section provides details about the reports generated by the Configuration Profiler, and includes the following:

Report Type

The configuration profiler allows you to report on the configuration currently open in the console. General reports are produced to assist auditing and compliance such as Sarbanes Oxley or HIPAA. You can produce custom reports to assist in troubleshooting large configurations.

The configuration profiler is a reporting tool that can be used to generate quick reports based on the details of a product configuration which is currently open. The report can be generated in the following ways:

- Complete Report – produces a report which includes all aspects of the configuration.
- Report based on specific criteria – produces a report based on the specified criteria as selected in the Report Criteria section.

**NOTE:** Enter an asterisk (*) to see all actions controlled by a particular type of condition.

Report Criteria

Use the criteria to specify what is to be included in the report.

Enter the value or select an option to match for any of the following:

- User/Group – enter the name of a user or user group you wish to include in the report.
- Application – enter the name of an application you wish to include in the report.
- Application Group – select an application group to include in the report or select the asterisk (*) to produce output for all groups.
- CPU – select Include or Exclude to show or hide CPU settings in the report.
- Memory – select Include or Exclude to show or hide Memory settings in the report.

**NOTE:** The User/Group and Application fields support wildcard character matching using the asterisk (*) and question mark (?) characters. The asterisk represents zero or more characters, while the question mark (?) wildcard represents zero or one characters.
Report Output

Generate a report by selecting **Configuration Profiler** from the Home ribbon of the console.

The report output is produced in sections and sub-sections covering the following details of the configuration:

- **Feature Options** — Provides details about features which are enabled, in passive mode, or include system processes.
- **Application Groups** — Provides details of the application groups which you have configured including the description and path of each application in the group and any command lines which are applicable.
- **Resource Planning** — Provides details of the resource planning settings for user groups and Application Groups including CPU, Memory and Disk settings.
- **Thread Throttling** — Provides details of the Thread Throttling settings including CPU monitor, clamping action and exceptions.

The report displays in the Preview window where you can manage the following:

- **File settings**: Page Setup, Print, Export (PDF or image file), Send via email (PDF or image file)
- **Background**: Color and Watermarks.
Resolve Configuration Violations

Violations can occur when conflicting values are present in a Performance Manager configuration. If you attempt to save a configuration with conflicts, the Configuration Violations dialog displays. This identifies the area of the configuration where the conflict arises and provides a description of the issue. All issues must be resolved before the configuration can be saved.

The following table provides details of configuration violations that can occur.

<table>
<thead>
<tr>
<th>Violation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Group allocated more than once in the resource plan</td>
<td>In <strong>Resource Configuration &gt; Resource Planning</strong>, only one occurrence of an Application group can be allocated in the resource plan.</td>
</tr>
<tr>
<td>User Group allocated more than once in the resource plan</td>
<td>In <strong>Resource Configuration&gt; Resource Planning</strong>, only one occurrence of a user group can be allocated in the resource plan.</td>
</tr>
<tr>
<td>CPU Reservation value exceeds CPU Limit</td>
<td>In <strong>CPU</strong>, the Reservation must be less than or equal to the Limit.</td>
</tr>
<tr>
<td>The Physical Memory Minimum limit exceeds the Maximum</td>
<td>In <strong>Memory &gt; Physical Memory</strong> the Minimum limit must be less than or equal to the Maximum limit.</td>
</tr>
<tr>
<td>[Clamp CPU by] exceeds [Apply clamping when CPU reaches]</td>
<td>In <strong>Thread Throttling</strong>, <strong>Clamp CPU</strong> by must be less than or equal to <strong>Apply clamping when CPU reaches</strong>.</td>
</tr>
<tr>
<td>[Do not clamp threads below] exceeds [Do not clamp processes below]</td>
<td>In <strong>Thread Throttling</strong>, <strong>Do not clamp threads below</strong> must be less than or equal to <strong>Do not clamp processes below</strong>.</td>
</tr>
<tr>
<td>Application Soft Memory Limits has been enabled but no action has been selected.</td>
<td>When applying Application Memory Limits to an Application Group and choosing a soft limit, an action of either close or terminate must be selected.</td>
</tr>
<tr>
<td>CPU Reservations &amp; Limits have been enabled but a value of zero has been entered.</td>
<td>When applying CPU Reservations and Limits a value greater than zero must be entered.</td>
</tr>
</tbody>
</table>
Feature Options

Performance Manager Feature Options provides system-wide settings that affect all users with the deployed configuration.

To access the Feature Options, click Options in the Resources Setup ribbon.

Feature Usage

For each Performance Manager feature, specify the following:

- **Enabled** - If selected, the feature is enabled.
- **Passive Mode** - If selected, the feature runs passively in the environment. Performance Manager makes no changes to the system, however it monitors and raises audit events where configured.
- **Include System Processes** - If selected, system processes are included for the feature.
Application Memory

Configure the content of the Close and Terminate warning messages. The following settings are available:

- **Close Message Details** - Configure the title and message displayed when applications are due to be closed for exceeding the specified application memory limit.
- **Terminate Message Details** - Configure the title and message displayed when applications are terminated for exceeding the specified application memory limit.
Excluded Applications

Add applications to exclude from Share Factor allocations and Thread Throttling policies.
Multi-process Applications

Add multi-process applications, such as web browsers, to efficiently manage CPU and memory resources for processes that spawn additional helper processes of the same name.

This feature allows multiple instances of the same process to be consolidated when considering the window's state - foreground/background and maximized/minimized. For Microsoft Internet Explorer, this means each tab can be managed independently. For Google Chrome and other applications, Performance Manager calculates a summary window state so that the same foreground/background and minimized/maximized limits are applied to all matching processes based on their compounded windows state. This applies even if some matching processes have no windows or always have a fixed windows state, for example, if a helper process is always 'not visible' or in the background.
General

Apply general settings such as Share Factor Aggressiveness and Session Idle Timeout.

Specify the following options on the General tab:

- **Share Factor Aggressiveness** - Use the slider to set a value for Share Factor Aggressiveness. This value determines how quickly Performance Manager reacts to changes in the CPU load.
  
  When the slider is set to Max, Performance Manager reacts quickly to the changes in load. This can cause Performance Manager to take unnecessary action against processes that have brief spikes in CPU load and cause control over high demand processes to be lifted too soon if they briefly lower their demand for CPU resources.
  
  When the slider is set to Min, Performance Manager monitors the effects of the changes over time, rather than taking immediate action. This can cause Performance Manager to take too long to control high loading CPU processes to free processes from control once they have definitively transitioned to a state of low CPU demand.

- **System Memory Settings** - Set whether overall system memory usage must reach a specified threshold before memory control is applied. Use the slider to set the threshold level.
- **Session Idle Timeout** - The Session Idle Timeout refers to the period when no keyboard and mouse activity takes place. This condition can be used in a rule to specify changes in resource allocations when the idle time reaches a set duration. The default setting is 10 minutes of no keyboard activity and mouse activity.

- **Number of CPUs** - Set the number of CPUs which can be used in CPU affinity settings in the CPU tab of a Resource Planning > Resource Allocations node.
Application Groups

Application Groups are a collection of applications whose CPU, memory and disk resources can be controlled together. Applications can be added either manually or using Application Discovery.

In the configuration, Application Groups can be combined with specific users to allocate resources at a granular level. A typical Application Group could contain graphic-intensive applications which utilize a high proportion of system resources. A rule could be added to allow members of the Graphics Design team to run these applications with adequate resources.

Create Application Groups Manually

1. Select **Application Groups** in the navigation tree.
2. Click **Add New** from the Resources Setup ribbon.
   The Add New Application Group dialog displays.

3. In the Name field, enter a name for the Application Group.
4. From the Type drop-down, select the type of applications to be added to the Application Group:
   - Desktop Applications.
   - Services.
   - 16-bit Applications.

5. Click **Add New**.

6. Enter an executable name, executable path or folder path in the Path field.
   Both the asterisk (*) and question mark (?) wildcard characters can be used in the file or folder path. The asterisk wildcard represents zero or more characters and the question mark wildcard represents zero or one character.
   For example, C:\Folder* matches all executables within C:\Folder.

   **TIP:** To convert text to available Environment Variables, click the percentage sign and **Convert To Use Environment Variables** after entering the name or path.

7. If the Path field contains regular expressions, select **Use regular expressions**.

8. To match the command line, select **Enable command line matching** and enter the relevant command line.

9. In the Description field, enter a description for the application.

10. Click **Next**.
    The Select Where to Go dialog displays.

11. Select one of the following options:
    - **Allocate Resources** - Adds the new Application Group to the Resource Planning node so that rules can be added.
    - **Finish** - Does not add the Application Group to the Resource Planning node. The Application Group can be added manually by selecting **Add Applications** from the Resources Setup ribbon.
Create Application Groups Using Application Discovery

Application Discovery can be used to populate Application Groups with installed applications, running processes or file types.

Application Discovery can be run on the local or a remote computer with the Performance Manager Agent installed.

1. Select **Application Groups** in the navigation tree.
2. Click **Add New** from the Resources Setup ribbon.

   The Add New Application Group dialog displays.

3. In the Name field, enter a name for the Application Group.
4. From the Type drop-down, select the type of applications to be added to the Application Group:
   - Desktop Applications.
   - Services.
   - 16-bit Applications.
5. Click **Discover Applications**.
A dialog to select the endpoint displays.

6. Select the endpoint on which to perform the analysis:
   - Select the local machine name to perform an analysis on the local endpoint.
   - Select **a remote computer** to perform an analysis on a remote computer. The Connect to a Remote Computer dialog displays. Specify or navigate to the remote computer. Options are available to navigate to a computer on the network, one in the AppSense Management Center or to a favorite computer.

The Application Discovery dialog displays.
The dialog contains tabs to select installed applications, running processes and file types. It may take a few minutes to populate the data from the endpoint.
Once the data is populated, select the installed applications, running processes and file types to add to the Application Group. Filters can be applied by entering text into the Filter field.

7. Click **Next**.
The Add New Application Group dialog displays.
The selected items from Application Discovery are added to the dialog. Review the contents and, if necessary, amend the Path, Command Line and Description fields for each application.

8. Click **Next**.
The Select Where to Go dialog displays.

9. Select one of the following options:
   - **Allocate Resources** - Adds the new Application Group to the Resource Planning node so that rules can be added.
   - **Finish** - Does not add the Application Group to the Resource Planning node. The Application Group can be added manually by selecting **Add Applications** from the Resources Setup ribbon.
Resource Planning

CPU, memory and disk resources are allocated according to the Resource Plan within the configuration. Resource Planning nodes are top-level Application Groups or User Groups that define how the overall system resources are allocated. Each Resource Planning node contains one or more sub-nodes to match specific Application Groups or User Groups. Each sub-node then contains one or more rules match application attributes.

Evaluation Order

Performance Manager evaluates items in the following order to apply the Resource Plan:

1. Resource Planning nodes in descending order.
2. Resource Planning sub-nodes in descending order.

The arrows in the navigation pane and work area show the order of precedence. In the above example, the Development node is evaluated first. If the user matches the User Group, then the sub-nodes under Development are evaluated.

Resource Planning Nodes

Resource Planning nodes are top-level User Groups or Application Groups. Resources are first allocated to the Resource Planning nodes. Finer control can be applied by adding sub-nodes for specific Application Groups or User Groups.

Add Resource Planning Nodes Based on User Groups

1. Select the Resource Configuration navigation button.
2. Select Resource Planning from the navigation tree.
4. Choose a user or group using one of the following methods:
   - Enter the name of a user or group in the Name field.
   - Click the percent sign (%) and add an environment variable.
   - Click the ellipses (...) and browse to the user or group.

The User Group is added as a Resource Planning node to enable its resources to be managed.
Add Resource Planning Nodes Based on Application Groups

1. Select **Resource Planning** from the navigation tree.
2. On the Resources Setup ribbon, click **Add Applications** and select an Application Group for which to create a Resource Plan or create a new Application Group.

The Application Group is added as a Resource Planning node to enable its resources to be managed.

Re-order Resource Planning Nodes

1. Select a **Resource Planning** node from the navigation tree.
2. Select either **Move Up** or **Move Down** from the Resources Setup ribbon.

The Resource Planning node is moved up or down in the list.

CPU Share Factor

CPU Share Factor allows the CPU resource to be split between Resource Planning nodes.

It allocates User Groups or Application Groups a greater or lesser proportion of CPU time.

The pie chart in the work area provides a visual representation of the CPU allocation between the nodes. In the above example, the pie chart represents the relative CPU share between the Resource Planning nodes entitled Development, HR, Sales and <Other Users>.

To set CPU Share Factor:

1. Select a **Resource Planning** node in the navigation tree.
2. In the work area, select the **CPU** tab.
3. In the CPU Share Factor section, adjust the share factor by either using the slider or entering a value into the box.

   As the CPU Share Factor is adjusted, the pie chart updates to provide a visual representation of the resource allocation between the Resource Planning nodes.

The CPU Share Factor of the Resource Planning node, relative to the other Resource Planning nodes, is set and the processor time is split accordingly on endpoints.
Resource Planning Sub-nodes

Sub-nodes allow a finer level of control to be applied for specific Application Groups or User Groups. Rules within a Resource Planning sub-node allow resources to be allocated based upon attributes of the application window, such as whether it is maximized or minimized.

Add Resource Planning Sub-nodes Based on Application Groups

1. Select a Resource Planning node from the navigation tree.
2. On the Resources Setup ribbon, click Add Applications and select an Application Group for which to create a Resource Plan.

The Application Group is added as a Resource Planning node to enable its resources to be managed.

Add Resource Planning Sub-nodes Based on User Groups

1. Select a Resource Planning node from the navigation tree.
2. On the Resources Setup ribbon, click Add Users/Groups and select Select User/Group.

The Select User/Group dialog displays.
3. Choose a user or group using one of the following methods:
   ○ Enter the name of a user or group in the Name field.
   ○ Click the percent sign (%) and add an environment variable.
   ○ Click the ellipses (...) and browse to the user or group.

The User Group is added as a sub-node of the Resource Planning node to enable its resources to be managed.

Re-order Resource Planning Sub-nodes

1. Select a Resource Planning sub-node from the navigation tree.
2. Select either Move Up or Move Down from the Resources Setup ribbon.

The Resource Planning sub-node is moved up or down in the list.
Rules

Rules within a Resource Planning sub-node allow resources to be allocated based upon attributes of the application window, such as whether it is maximized or minimized.

In a typical setup, maximized windows in sessions that are connected, not idle and unlocked are given a greater proportion of the available resources.

Add Rules for Resource Planning Sub-nodes

1. Select a Resource Planning sub-node from the navigation tree.
2. From the Resources Setup ribbon, select Add Rule.

A new rule is created within the work area.

Add Conditions to Rules for Resource Planning Sub-nodes

1. Select a Resource Planning sub-node from the navigation tree.
2. In the work area, select a rule.
3. Select the Conditions tab.
4. Set one or more of the following conditions:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Position</td>
<td>Set whether the assigned application window is Minimized, Not Minimized, in the Foreground or in the Background.</td>
</tr>
<tr>
<td>Session Connected</td>
<td>Set whether the assigned application is running in a session that is Connected or Disconnected.</td>
</tr>
<tr>
<td>Session Idle</td>
<td>Set whether the assigned application is running in a session that is Idle or Not Idle.</td>
</tr>
<tr>
<td>Desktop</td>
<td>Set whether the assigned application is running in a session that is Locked or Unlocked.</td>
</tr>
</tbody>
</table>

The condition is added to the rule. The name of the rule is updated in the work area based upon the selected conditions.

Re-order Rules for Resource Planning Sub-nodes

1. Select a Resource Planning sub-node from the navigation tree.
2. From the Resources Setup ribbon, select either Move Up or Move Down.

The rule is moved up or down in the list.
CPU Share Factor for Resource Planning Sub-nodes

CPU Share Factor allows the CPU resource to be split between Resource Planning sub-nodes. It provides Application Groups or User Groups a greater or smaller proportion of CPU time.

The pie chart in the work area provides a visual representation of the CPU allocation between all sub-nodes in the configuration.

To set CPU Share Factor:

1. Select an Resource Planning sub-node from the navigation tree.
2. In the work area, select a rule.
3. Select the CPU tab.
4. In the CPU Share Factor section, adjust the share factor by either using the slider or entering a value into the box.

As the CPU Share Factor is adjusted, the pie chart updates to provide a visual representation of the resource allocation between the Resource Planning sub-nodes.

The CPU Share Factor of the Resource Planning sub-node, relative to the other Resource Planning sub-nodes, is set and the processor time is split accordingly on endpoints.
CPU Reservations and Limits for Resource Planning Sub-nodes

CPU Reservations ensure that the Application Group or User Group has a guaranteed level of available CPU resource. CPU Limits restrict the amount of CPU resource available to the Application Group or User Group. To set CPU Reservations and Limits:

1. Select a Resource Planning sub-node from the navigation tree.
2. In the work area, select a rule.
3. Select the CPU tab.
4. In the CPU Reservation & Limits section, set one or more of the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation</td>
<td>Ensure that a guaranteed level of CPU resource is available to the Application Group or User Group. At times of peak demand on the system, minimum reserved resources are obtained and the remaining resources are reallocated according to CPU Share Factors.</td>
</tr>
</tbody>
</table>
| Limit | Prevent the Application Group or User Group exceeding specific CPU levels. Select the type of limit:  
- **Soft Limit** - The restriction applies during high CPU demand only.  
- **Hard Limit** - The restriction applies even when spare capacity is available. |

As the Reservation and Limit fields are adjusted, the bar chart updates to provide a visual representation of the resource allocation relative to other sub-nodes.

The CPU Reservation or Limit is set. Where the Reservation is specified, the sub-node has a guaranteed level of CPU resource. Where the Limit is specified, the sub-node has a limited amount of CPU resource.

CPU Affinity for Resource Planning Sub-nodes

CPU Affinity restricts the Application Group or User Group to one or more specific CPUs. To set CPU Affinity:

1. Select a Resource Planning sub-node from the navigation tree.
2. In the work area, select a rule.
3. Select the CPU tab.
4. In the CPU Affinity section, select **Enabled** and specify the CPU numbers.  
   - Use commas to specify individual CPUs or dashes to specify ranges of CPUs. For example, 0,2 uses CPUs 0 and 2 and 0-2 uses CPUs 0, 1 and 2.

The CPU Affinity is set. The sub-node has the specified CPUs available only.
Physical Memory Limits for Resource Planning Sub-nodes

Physical Memory Limits allow a minimum or maximum amount of memory to be configured for the Application Group. Options are available to trim the process memory on application startup or when the application enters the rule.

To set Physical Memory Limits:

1. Select a Resource Planning sub-node from the navigation tree.
2. In the work area, select a rule.
3. Select the Memory tab.
4. In the Physical Memory Limits section, select **Enabled**.
5. Specify the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum</td>
<td>Ensure that a guaranteed level of physical memory is available to the Application Group. At times of peak demand on the system, minimum reserved resources are obtained and the remaining resources are reallocated according to CPU Share Factors. Select the type of limit:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Soft Limit</strong> - The reservation applies during high memory demand only.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Hard Limit</strong> - The reservation applies even when spare capacity is available.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Prevent the Application Group exceeding specific physical memory levels. Select the type of limit:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Soft Limit</strong> - The restriction applies during high memory demand only.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Hard Limit</strong> - The restriction applies even when spare capacity is available.</td>
</tr>
<tr>
<td>Trim process memory on application startup</td>
<td>Trim process memory when the process has been created. The memory is trimmed only once.</td>
</tr>
<tr>
<td>Trim process memory when application enters this rule</td>
<td>Trims a process memory whenever the state matches the associated state rule.</td>
</tr>
</tbody>
</table>

As the Minimum and Maximum fields are adjusted, the bar chart updates to provide a visual representation of the resource allocation.

The Physical Memory Limits are set. Where the Minimum is specified, the sub-node has a guaranteed level of physical memory. Where the Maximum is specified, the sub-node has a limited amount of physical memory. The process is trimmed according to the settings.
Application Memory Limits for Resource Planning Sub-nodes

Application Memory Limits allow the amount of virtual memory available to an application to be restricted. Applications can be either closed or terminated for exceeding their limit.

To set Application Memory Limits:

1. Select a Resource Planning sub-node from the navigation tree.
2. In the work area, select a rule.
3. Select the Memory tab.
4. In the Application Memory Limits section, select Enabled.
5. Specify the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Limit</td>
<td>Set the memory level, in megabytes, at which the action is taken. Select the type of limit:</td>
</tr>
<tr>
<td></td>
<td>○ Soft Limit - The limit applies during high memory demand only.</td>
</tr>
<tr>
<td></td>
<td>○ Hard Limit - The limit applies even when spare capacity is available.</td>
</tr>
<tr>
<td>Close application after</td>
<td>Users are prompted to close the application once the application has exceeded the limit for the specified number of minutes.</td>
</tr>
<tr>
<td>Terminate application after</td>
<td>The application is terminated once the application has exceeded the limit for the specified number of minutes.</td>
</tr>
</tbody>
</table>

**CAUTION:** Terminating an application can result in data loss within the application.

As the Limit field is adjusted, the bar chart updates to provide a visual representation of the resource allocation.

The Application Memory Limits are set. The application is closed or terminated after exceeding the limit for the specified time.

Windows Fair Share

A reduction in performance management efficiency may occur where Windows Fair Share is enabled on machines with the Performance Manager agent installed. It is therefore recommended that Windows Fair Share is disabled.

To disable Windows Fair Share, set the following registry values:
<table>
<thead>
<tr>
<th>Key</th>
<th>Value Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\SessionManager\DFSS</td>
<td>Enable DFSS</td>
<td>0</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\TSFairShare\Disk</td>
<td>EnableFairShare</td>
<td>0</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\TSFairShare\NetFS</td>
<td>EnableFairShare</td>
<td>0</td>
</tr>
</tbody>
</table>
Thread Throttling

Thread Throttling sets a system-wide CPU thread throttling policy that triggers when the system is heavily loaded. The throttling provides unutilized processor time to allow new users to log on or new applications to execute.

Performance Manager samples system performance data at one second intervals. Once the system is detected to be in a heavily loaded state for the specified interval, threads are clamped to achieve the specified percentage reduction in server load. The clamp is unapplied after the specified duration. Where necessary, clamping is reapplied repeatedly until the processor remains stable.
Configure Thread Throttling

To configure Thread Throttling:

1. Select **Thread Throttling** in the navigation tree.
2. Select **Enabled**.
   
   Specify the following settings:

<table>
<thead>
<tr>
<th>Section</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor</td>
<td>Set the CPU utilization percentage and the internal (in seconds) for which the CPU must remain at the utilization level before clamping is applied. Additionally, set whether the clamping occurs when any one processor reaches the threshold on multi-processor systems.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> It is recommended that the interval does not exceed 60 seconds.</td>
</tr>
<tr>
<td>Action</td>
<td>Set the percentage by which to clamp the CPU and for how long the clamp is applied (in seconds).</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> It is recommended that the clamp duration does not exceed 60 seconds.</td>
</tr>
<tr>
<td>Exceptions</td>
<td>Set the minimum CPU utilization for processes and threads to be clamped. Processes and threads below the specified level are not clamped.</td>
</tr>
</tbody>
</table>

As the options are set, the chart in the work area updates to provide a visual representation of the Thread Throttling behavior.

Thread Throttling is enabled for all users on the system. When the system reaches the specified CPU utilization threshold for the specified interval, threads are clamped by Performance Manager.

**Example**

The example below explains typical Thread Throttling behavior. As the options are set in the console, the chart updates to provide a visual representation of the behavior.
**Label** | **Description**  
--- | ---  
A | The CPU utilization reaches the threshold of 95%, as specified in the Monitor section.  
B | The CPU remains at or above the threshold of 95% for 20 seconds, as specified in the Monitor section.  
C | The initial clamping of 45% (from 95% to 50%) is applied, as specified in the Action section.  
D | The CPU remains clamped by 45% (from 95% to 50%) for 18 seconds, as specified in the Action section.  
E | The clamping is unapplied after the clamp duration expires. The clamp is reapplied if the CPU utilization reaches the threshold of 95%, as specified in the Monitor section.  
F | The minimum percentage for process clamping. Processes utilizing below 35% are not clamped, as specified in the Exceptions section.  
G | The minimum percentage for thread clamping. Threads utilizing below 15% are not clamped, as specified in the Exceptions section.
Include System Processes in Thread Throttling

By default, system processes are not included in Thread Throttling. This ensures system processes continue running for critical system tasks.

1. Click **Options** on the Resources Setup ribbon.
   The Feature Options dialog displays.
2. Select the **Feature Usage** tab.
3. On the Thread Throttling row, select **Include System Processes**.
4. Click **OK**.
   System processes are included in the Thread Throttling behavior.
Auditing

Use Auditing to define rules for the capture of auditing information, you can setup rules about where event data is stored for logging to a local file and the application event log, and you can setup filters to specify the events you want to capture in the log.

About Auditing

Local Auditing allows you to specify whether to log events in the Windows Application Event Log or to a custom AppSense Event Log. Events can be written to a local file in CSV or XML format.

By default, the log file is located at
%SYSTEMDRIVE%\AppSenseLogs\Auditing\PerformanceManagerEvents_%COMPUTERNAME%.csv (or .xml)

An alternative location can be configured for the log file. In this mode, auditing also includes an event filter to log only specific events.

When managed by the AppSense Management Center, events are forwarded via the Deployment Agent. Under these conditions, event data storage and filtering is configured through the AppSense Management Console.

Make events anonymous

Specify whether events are to be anonymous. If, Yes, the computer name and user name is omitted from all events. Anonymous logging also searches the file path for any instances where a directory matches the username and replaces the directory name with the string USERNAME or COMPUTERNAME.

Send events to local file log

Select whether to send events to the local file log. If Yes, the events are sent to the local log file as specified in the Text box. The default is:
%SYSTEMDRIVE%\AppSenseLogs\Auditing\PerformanceManagerEvents_%COMPUTERNAME%.csv

Local file log format

Specify whether the event log is to be saved in XML format or CSV format.
Local Events

The Event filter table is a comprehensive list of all events and is used to select the events you want to audit. You can sort the table numerically by ID number, or alphabetically by Event Name or Event Description. Selected events are highlighted in bold. Click **Toggle selected** to change the states between selected and cleared.

**NOTE:** Events are reported to the local Windows Event Log or the local AppSense Event Log, according to the Deployment Group Events settings, and also to the Management Server by the Deployment Agent (CCA), unless otherwise indicated.

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Event Name</th>
<th>Event Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>9104</td>
<td>Thread Throttling Clamping On</td>
<td>Total CPU Usage has exceeded a threshold and will be clamped.</td>
<td>Information</td>
</tr>
<tr>
<td>9105</td>
<td>Thread Throttling Clamping Off</td>
<td>Total CPU Usage has fallen under a threshold and clamping will stop.</td>
<td>Information</td>
</tr>
<tr>
<td>9106</td>
<td>Application CPU Usage clamping On</td>
<td>An Application has exceeded its CPU Usage limit.</td>
<td>Information</td>
</tr>
<tr>
<td>9107</td>
<td>Per Application Memory Usage Exceeded</td>
<td>Memory usage for a particular application has exceeded a threshold.</td>
<td>Information</td>
</tr>
<tr>
<td>9108</td>
<td>Per Application Memory Usage Reduced</td>
<td>Memory usage for a particular application has dropped below a threshold.</td>
<td>Information</td>
</tr>
<tr>
<td>9109</td>
<td>Per Application Memory Usage Terminated</td>
<td>An application has been terminated because it used too much memory.</td>
<td>Warning</td>
</tr>
<tr>
<td>9110</td>
<td>Application CPU Usage Clamping Off</td>
<td>An application has now fallen below its CPU Usage limit and will no longer be clamped.</td>
<td>Information</td>
</tr>
<tr>
<td>9115</td>
<td>Working set trimmed</td>
<td>Working set for an application has been trimmed.</td>
<td>Information</td>
</tr>
<tr>
<td>9116</td>
<td>CPU Affinity changed</td>
<td>CPU Affinity of an application has changed.</td>
<td>Information</td>
</tr>
<tr>
<td>9119</td>
<td>Per Application Hard Memory Limit Reached</td>
<td>Memory usage for a particular application has reached its maximum limit</td>
<td>Warning</td>
</tr>
<tr>
<td>9120</td>
<td>Thread Throttling - Clamped Processes</td>
<td>Total CPU Usage has exceeded a threshold and applications will be clamped.</td>
<td>Information</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
<td>Event Description</td>
<td>Type</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>9121</td>
<td>Application CPU Soft Limit - Started</td>
<td>Because of the overall CPU Usage a CPU soft limit will be applied to an application.</td>
<td>Information</td>
</tr>
<tr>
<td>9122</td>
<td>Application CPU Soft Limit - Stopped</td>
<td>An application will be no longer controlled by an CPU soft limit.</td>
<td>Information</td>
</tr>
<tr>
<td>9123</td>
<td>Application CPU Reservation Applied</td>
<td>A CPU Usage reservation was applied to an application.</td>
<td>Information</td>
</tr>
<tr>
<td>9170</td>
<td>Settings not found in package</td>
<td>Some configuration settings were not found in the configuration package.</td>
<td>Error</td>
</tr>
<tr>
<td>9171</td>
<td>Settings not valid in package</td>
<td>Some configuration settings in the configuration package were not valid.</td>
<td>Error</td>
</tr>
<tr>
<td>9172</td>
<td>Settings loaded from package</td>
<td>The configuration settings were successfully loaded from the configuration package.</td>
<td>Information</td>
</tr>
<tr>
<td>9173</td>
<td>Settings applied live to the Agent</td>
<td>The configuration settings were applied live to a running Performance Manager Agent.</td>
<td>Information</td>
</tr>
<tr>
<td>9174</td>
<td>Package has been loaded and all settings applied</td>
<td>All settings in the package have been applied to the Agent.</td>
<td>Information</td>
</tr>
<tr>
<td>9175</td>
<td>The package is invalid</td>
<td>The configuration package is invalid.</td>
<td>Error</td>
</tr>
<tr>
<td>9176</td>
<td>Package not found</td>
<td>The configuration package does not exist.</td>
<td>Warning</td>
</tr>
<tr>
<td>9197</td>
<td>Valid License Found</td>
<td>Performance Manager is licensed.</td>
<td>Information</td>
</tr>
<tr>
<td>9198</td>
<td>Invalid License Found</td>
<td>Performance Manager has detected a product license which is not compatible with the current used Performance Manager version. Upgrade your Performance Manager license.</td>
<td>Error</td>
</tr>
<tr>
<td>9199</td>
<td>Valid License Not Found</td>
<td>Performance Manager is not licensed.</td>
<td>Error</td>
</tr>
<tr>
<td>9235</td>
<td>NP-VDI Config path Update</td>
<td>Detected the Deployment Agent has updated the endpoint native configuration path.</td>
<td>Error</td>
</tr>
<tr>
<td>9236</td>
<td>System Memory Exceeded Threshold Warning</td>
<td>The system memory has exceeded the minimum threshold. New processes will be eligible for memory limitations.</td>
<td>Warning</td>
</tr>
<tr>
<td>9237</td>
<td>System Memory Exceeded Threshold</td>
<td>The system memory has fallen back below the minimum threshold. New processes will not be</td>
<td>Warning</td>
</tr>
</tbody>
</table>
Lapse

monitored for memory limitations.

## System Events

The following are non-configurable system events:

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Event Name</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8095</td>
<td>No Configuration found</td>
<td>[Product Name] cannot find a valid configuration</td>
</tr>
<tr>
<td>8096</td>
<td>Configuration Upgraded</td>
<td>A configuration for a previous version of [Product Name] has been detected and upgraded.</td>
</tr>
<tr>
<td>8099</td>
<td>Invalid License</td>
<td>[Product Name] software is not licensed.</td>
</tr>
</tbody>
</table>
Environment Variables

You can convert to environment variables certain types of data which are manually entered in different areas of the Performance Manager console. For example, directory paths to applications. Environment variables are available by selecting the percent sign (%) where it appears in particular dialogs. For example, the Add New Application Group dialog.

The following table shows the types of environment variables and where they can be used in the Performance Manager console.

<table>
<thead>
<tr>
<th>Environment Variables</th>
<th>Add Users/Groups</th>
<th>Add Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>%ProgramFiles%</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>%SystemRoot%</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>%SystemDrive%</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>%CommonProgramFiles%</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>%AllUsersProfile%</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>%ComputerName%</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>%WinDir%</td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>
Streamed Applications

To set up Citrix XenApp streaming applications to work with Performance Manager you need to specify certain exclusions, as follows:

1. Navigate to Citrix Streaming Profiler for Windows.
2. Open the Application Profile.
3. Highlight the relevant Target and select the Edit menu.
5. Select Rules. The Rules work area displays on the right hand side.
6. Click Add in the Rules work area. The New Rule Select Action and Objects dialog displays.
7. In the Action section leave the default setting as Ignore.
8. In the Object section select Named Objects and click Next. The New Rule Select Objects dialog displays.
10. Add \??\pipe\AppSense* and click OK. This displays in Named Objects on the New Rule Select Objects dialog.
11. Click Next to display the New Rule Name Rule dialog.
12. Enter a name for the rule or accept the default and click Finish.
13. Click OK. The Target Properties screen re-displays and the Ignore all named objects rule is now listed in the work area on the right hand side.
14. Save the profile.
15. Repeat for each application profile as required.